AN1029 - Using Net2 Timesheet

Timesheet software

This program provides basic time and attendance reporting when used with the Net2 access control system.

A user must be defined as an operator to log in to Net2. The level of detail available is set by the operator
privilege they are assigned.

For information on Operators please refer to: AN1073 - Adding Net2 Operators < http://paxton.info/973 >

Timesheet calculates 'Hours Worked' based on a users Clock In/Out times. This information can be displayed
for a week, month, etc, and may be exported to a payroll package if required.

The Net2 server should be left running at all times or the clocking information may not be stored in
the correct sequence.

Configuring Clocking In and Clocking Out readers

Before the Timesheet software can be used, at least one reader needs to be configured as a 'Clocking in
reader' and another reader as a 'Clocking out reader. This may be on the same ACU or a different one.

You can configure multiple Clocking In and Clocking Out readers if required.

' )
@ Select the required door in the Doors screen

Reader1 | Reader2 | Alaim | Events| Fire alarm inputs | Intruder Alaim | Acosss rights |

Reader details

Mame Main Door (In)

Reader lype [Patton reader =)

Keypad type [Mare z)

Taken data format [Defaut = [ Newtamat |

@ Select 'Clocking In reader' as the operating mode

Operating mode

Reader aperating mode -

& Clocking in reader

, , [T Timed operating modes - This Alone-forditerssi-eadsreperatlon duing 4 selected limezone.
Press 'Apply' to save the changes During s imescn o001 0
This reader wil agerate as &
- Reader action - This is what wil happen when a valid access is granted
Select another door reader and create a S SEmains § Copaiis

'Clocking out reader'

J

Dedicated readers are required for Clocking In and Clocking Out and cannot be used to control access
through a door. Separating these functions ensures accurate time and attendance information.

Reviewing staff working hours

. N\
. Hours worked within the selected date L a2
. File View Tools Help
range can be dlsplayed for all users by EfEqport Gprint | By Find user §HAdd entry | 2 Details +
selecting Users in the tree view
= &
ET R, Fiob Date peiod [Lastmorth =] ¢~ E:ﬁ:ﬂ'::;:h
f . Date [ Doy [In [ ou Hows [ Rate [ Total [ Category Not
Hours worked for employees belonglng to 20/08/2009 Thusday 134605 235963 101354 1000 10232 Hous worked
a particular department can be displayed 21/08/2009  Fiidap 14412 ZHS00 091847 1000 9253 Hous worked
=7 by selecting the Department name in the
tree view
« 1, b N
To view details regarding a particu|ar user Fiepott iom 01 August 2005 to 31 August 2009 System engineer
select their name in the tree view
- J
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How to edit a record

If a user clocks in/out at the wrong time (or forgets altogether) then it may be necessary to edit their record.

~N =0

4 . ; :
Select the user's name in the tree view.
@ Any errors will be highlighted in red. g0 ety

,—_| * Calendar month
Date period | This month hd L —

TO change a C|0Ck in/Out tlme S|mp|y double | Date | Day | In ‘ Out ‘ Haurs | Rate ‘ Total | Category Motes
R X . 01/03/2003 Tuesday  0B4E25 IR1345 052713 1000 8455 Howswoked
click on the time you wish to change 02/03/2009  Wednesday 054351 170325 111334 1000 11225 Hows worked
1 03/05/2009  Thureday 044314 000000 1000 0000 Clackedin  Eror No OUT time has been recorded

10/09/2008  Thursday 054243 151036 032747 1.000 9463 Hours worked

@ Once you have made the change click
anywhere else on the screen

EEEE

gAdd entry

@ The edited time is displayed as blue to indicate
it has been changed

. ’—_‘ (¥ Calendar month
Diate period | This morth |

. 1 1 . | Date ‘ Day | In ‘ Out ‘ Hours | Rate ‘ Total ‘ Category HNotes
@ Click Apply to commit the Change(s) 14/03/2003  Monday 054509 155631 109122 1000 10163 Howsworked
\_ _J 150972000 Tuesdsy 140825 |36 w3031 1000 9053 Housworked

16/0%/2009  Wednesday 074007 18G9 TI7E1Z 1000 11270 Hours worked

[l [ h |

4 P \ fembeer 2009 Systemergineer | 030311 |9.05Houws |12 iems &4 [Local)
i i To add a record that does not already exist
select the 'Add entry' button from the toolbar B Add entry ==
g Users -
- Egg Stait dat
i i Select start and end dates, the category and A Cloaners atase 2 September 2009 =
. . -4 Cantract ? -
the total time period ® B Evorn ke End date 23 September 2009
= Category: Doctor's appaintment -
P Time logged per day W
@ Select 'Add' to add the records ™ Inchide weskends
‘Wwhen the date range covers a weekend, should the weskend
dates be included? Check this box if pou want to include
weekend dates
e
. Pending it
@ Click 'OK' to save the new record(s) e e
\§ J -

Cancel 0k

Once a record has been added the Clock in/out times can be edited by double clicking.

How to export hours worked information

User data can be exported to a payroll package if required. The information is exported in standard text or
CSV (Comma Separated Variable) format.

4 2\
@ Select the user or department —
FF Met? Tirmesheet
Fitefoy—Toroir=——Hulr
Pnnt B Find user  §25Add entry
@ Select the 'Date period' from the drop down list T T —
FF save as... @ ‘ T
— 2 \\j/'\:/r [T « Docurments - ‘¢, [ search )
@ Select the 'Export' button from the toolbar ; File name: | -
; Save as type: IText file (* bxt) 'J
N @ srowse Fotders =
@ Select the destination, file name and format
= required.
2 ;
Report from 01 September 2009 to 30 September 2009 Sustem engineer

@ The file may be edited in Excel to render it into
a suitable format for the payroll package
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How to configure holidays

E Metd Timesheet
4 N\
— File  View | Tools | Help
Select 'Tools' /'Edit user details' E
. A E Det
Edit user details
@ Select the 'User categories' tab -
Find user
Copy dat Ctrl+C
Enter a value for each of the user categories
- Transfer holiday
N o Irmport public holidays
Options Ctrl+0

Select a category (Full time, Part time, etc.) and then define their Holiday and Working day hours.

£ User details

=15 =S

Add |

Users l

MHame | Holiday allowance | Working day [Hours) |
Full time: ztaff 25 750

Part tirme: staff 13 379

DK|

Cancel |

If an employee's holiday allowance needs to be adjusted outside of the normal entitlement; for example
Mike Evans has been given an additional 2 days as a bonus, his record can be updated as follows.

An employee starting mid-year can have a minus (-) adjustment to reduce the entitlement from the full year.

~

e
g User details El =] @
Select 'Tools' /'Edit user details' £ Tisers] User categories |
Mame 4 | Diepartment | Categoary | Shaow in viewer | | Huoliday adiustrient [2009) | HDﬁd-j
y Evanz, Mike Contractars Full time staff “Ves 2.00 days
@ Select the 'Users' tab Gosaling, Mandy Suppart Full time staff “es
. . | ’
@ A value for Holiday adjustment can be entered oK Cancel
\ J

See also the 'Transfer holiday' section to add unused holiday from a previous year.

Public holidays - import

Public holidays already set up in Net2 can be
copied across to Timesheet.

m UE&T Access - Met? Timesheet

File ‘iew | Tools | Help

. Add ent
In Net2, they are used to modify a users _ = _
access rights during these holiday periods. B3 05T CIEETS
Find user
These are of use to Timesheet to record public e
. . opy data Ctrl+C
holiday periods and removes the need to
manually enter this data. Transfer holida
Irmport public holidays
Options Ctel+0
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Select the option and then click 'Yes' The Public holiday dates will then be imported.

o

Please wait...

i

Importing public holiday infarmation. This may take several minutes to

complete.

If Public holidays have not been set up in Net2 or you wish to check on the dates, log in to Net2 and

select Options / Public holiday.

The list will display and can be edited as required.

Toolz | Optionz | Help

Options

General

Departments
Conbrol ]

Field names
2] Token types

vels | =) Token data formats

T

‘Delete’.

General | Departments | Field names | Token types | Token data forat: Public holidays |>

Enter a date then press 'Add' to add it to the lizt of public holidays. Tao remove the date, selec|

|05 Apil 2010

| Acdd

02 &pril 2010
05 &pril 2010

=
| Public halidays

03 May 2010
31 May 200

bl Camera integration

30 August 2010
27 December 2010

1 i |

28 December 2010

Delete

Ok ” Cancel ” Apply

Booking users holiday

Holiday is booked by selecting the 'Add entry' button from the toolbar and then select the user.

Select a holiday category and enter the start and end dates.

Stat date: [11 March 2010 =l
End date: [12 Mach 2010 =l
Categony: |Dn holiday j

Time logged per day

07:30:00 == Add

‘when the date range covers a weekend., should the weekend
dates be included? Check this box if you want to include
weekend dates.

[ Include weekends

Pending items
w| 11/03/2010: Arcoo, Mari - On holiday [07:30:00)
| 0, Mari - On holiday 10]

Canecel oK
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If a new holiday catagory needs to be created, select Options from the Tools menu.

Click on 'Add' and define a name. Once created you can set 'Yes' on 'Take as holiday'

Options Bl
General | Custom date range
Mame | Default (D ays) | Fiate | Take az holiday | Show In Summany =
Dientist's appointment 100 100 Ma Mo
Dioctor's appointment 1.00  1.00 Mo [ [x] L
Hours worked 100 1.00 No Mo i
Mon-paid leave 1.00 000 Mo [ [x]
OIff sick 1.00 1.00 Mo Mo
Orn holiday 100 1.00 Yes e
On holiday [&kd)] 050 1.00 Yes ez
On holiday [Fh) 080 1.00 Yes e
Owertime [x1.5) 100 150 Ma Mo s
4 1 2
Add
oK Catcel

How to generate a holiday report

A holiday report shows holidays booked, any adjustments and holiday allowance left.

EReport SPrint | @ Find user  $Add entry

Right click on the user's name
in the tree view

o

@ Select 'Generate holiday report’

=

il

Users.

NF
Clearers
Contractars

- Evans.Mke

i

b

I

User: Evans, Mike

Huoliday entitlement this year
Holiday adjustment

Total holiday entitlement this year
Days booked this year

Days accrued to date

Holiday entitlement to date

Holiday balance this year

Date: 29 September 2009

Summary of Holiday Booked this Year

User Holiday Summary for 2009

25 days
2 days

27 days
0 days
18.5 days
20.5 days

27 days

This is the default number of days haliday, for
the particular staff category

You can add or delete days from the default
holiday entitiement, to reflect days carried over,
or an employee starting mid year

This is the yearly entitlement + any days carried
aver from last year

This is the total of all holiday booked this year
(Past and future)

This is the number of days holiday accrued ta
date, based on the yearly entitlement

This is a total of accrued days £ any days
carried over

This is holiday entitiement + haliday carvied aver
- holiday taken

Fieport from 01 September 2003 to 30 S eptember 2003

Details of Holiday Booked this Year

System engineer 262items 3% (Local)

Transferring unused holiday from a previous year

If there is holiday entitlement remaining from a

previous year, it can be transferred across to the

current year by selecting this option.

This will overwrite any existing entries in each users

'Holiday adjustment' column and should be run

before any further changes to this value are made.

UK&T Access - Met? Timesheet

File  Wiew Help

Add entry
Edit user details

Find user

Ctrl+C

Copy data

Transfer holiday

Irmportpulic holidays

Options Ctrl+0

AN1029 - Using Net2 Timesheet




How to view a holiday chart

This chart displays all users or a department showing when users are absent through iliness or holiday.

4 )
@ Right click on Users or a
7 Department in the tree view

Cleaners
Contractars

@ Select 'View holiday chart' ,

Key

[ On sy
[T 0n holidays
[ 0 holiday
Public holiday
Off sick
[lother

@ Choose the relevant year to view
\ J

[ Met2 Timesheet
File View Tools

EfExport GPrint | 8y Find user  $Add entry

tarden, Rick
Albayrak, Eme
Fiand, Rt

Report from 01 August 2009 to 31 August 2003

October 2009

20301 23 45 678 910M2131415 1647161820 21 223 2425 2% 27 28283031 1 2 3

System engineer

_

36 items

& (Local

Em

How to configure overtime rates

It is possible to configure special overtime rates.

@ Select 'Options' from the Tools' menu

@ Select the Categories tab

@ The rate can be changed as appropriate

If the category does not already exist then a
new one can be created by selecting 'Add'

( N\

- J

Options | Mew category [==] =
General| | Please enter categomy name
Mame Cancel mary -
Dentist's
Doctar's g —
Hours o |Tra|n|ng
Mon-paid 1IEave Too o000 Mo Mo
Off sick 1.00 100 Mo Mo
Or holiday 1.00  1.00 Yes Yes
On holiday [Ak] 050 1.00 “Yes Yes
Or holiday [PH] 050 1.00 Yes ez
Oevertime [#1.5] 100 1.50 Mo Mo -
<| | o
Add |
ok | Cancel | |

The rate applies to time and NOT to money. For example 6 hours at Overtime(x1.5) becomes 9 hours.

How to get LED or buzzer confirmation of clocking in/out

An LED or buzzer can be used to confirm that a user's token has been read correctly. When a token is
presented to a Clocking in or out reader, relay 2 on that control unit switches momentarily. This output can be

used to switch power to an LED or buzzer.
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Who is In the building?

D ate period |T|:u:|a_l,l j
Idzer | Hours | Tatal (I [nA0ut D—Inliday taken
Allen, G 152414 5000t
Allen, H 000000 0000 Ot

@ Select 'Users' or a department from the tree view

@ Select the 'Date period' from the drop down list

Operator / Event Log

E Ewent log

| Drate | Time | Event tupe Operator [zer
@1 1/03/°2010 153330 Operator logged on Swstem enginesr
@1 1/035200 152414 Operatar logged on Syztem engineer
@1 1/035200 145253 Operatar logged on Syztem engineer
@1 1/032010 132302 Operator logged on Systemn engineer

[@ Select 'Event Log' in the 'View' menu J

Using Net2 Timeline

Net2 Timeline is a graphical representation of the data stored in the Net2 Timesheet. It allows you
to further examine the data that created that record but cannot directly edit the information. It has
additional features, like the event viewer, making it an ideal tool for HR departments.

See also:- AN1098 - Using Net2 Timeline < http://paxton.info/983 >
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